
Overview
The Follett 7100™ handheld wireless device allows you to perform many 
circulation, inventory, and collection and patron maintenance tasks remotely. 

If you have Destiny® and a wireless network, the 7100’s customized browser 
communicates directly with Destiny, allowing you to perform real-time 
transactions. When you are out of range of your wireless network or when 
your Destiny server is not available, you can use Follett Remote, a self-
contained application that allows you to collect barcode scans offline. Follett 
Remote records the information in data files that you later upload to your 
circulation system.
This document guides you through charging and setting up your 7100 and 
communicating with your workstation or wireless network. It includes the 
following sections:
• Getting Started
• Managing the Batteries
• Features of the 7100
• Setting Up the 7100
• Communicating with the 7100

Resources to help you
All Customers
For information on using your 7100 scanner, please view the eLearning 
available through the Follett School Solutions website at  
http://www.follettsoftware.com.

Getting Started
If you have just received your Follett 7100, verify that the carton contains the 
following items:
• 7100 mobile computer (the terminal)
• Main battery pack (3.7v, Li-ion)
• AC power supply
• Localized plug adapters
Note: Be sure to keep the original packaging in case you need to return the 
7100 terminal for service.
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Managing the Batteries
Once you have verified that you have everything you need, you next need to 
insert and charge the batteries.

The 7100 has two types of battery power: the main battery pack on the back 
panel and the backup battery located inside the 7100. The batteries work 
together to prevent data loss when you use the 7100 for long periods.

The 7100 ships with the main battery pack packaged separately from the 
unit, so you must insert the main battery into the terminal to charge both 
batteries.

Important: You must charge both batteries to full capacity before using the 
7100 for the first time.

Inserting the main battery pack
1. Release the hand strap to access the battery compartment more easily.
2. Remove the battery compartment cover by turning the cover’s pins 

upward and lifting the cover.
3. Insert the battery into the battery well with the label facing upward and 

the contacts facing downward. 
4. Replace the cover by inserting the top edge of the cover first, then the 

bottom. Turn the pins downward. 
Note: The battery cover must be in place before booting the unit.

5. Replace the hand strap.

Turn the cover pins upward and remove the cover to access the battery.
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Lift the bottom of the battery first to remove it from the device.

Charging the main battery pack
The 7100 terminal ships with both the main battery pack and internal backup 
battery significantly discharged of power. Before initial use, charge the main 
battery pack with the 7100 charging cable for a minimum of 4 or 6 hours 
depending on your battery. 

Important: Use only the peripherals, power cables, and power adapters from 
the manufacturer. Use of peripherals, cables, or power adapters from other 
manufacturers will void the warranty and may damage the 7100.

1. Attach the appropriate plug 
adapter to the plug of the 
power cable.

2. Insert the plug into an 
appropriate power source.

3. Plug the 7100 power cable 
into the DC Power Jack on 
the bottom end of the unit.
Note: If you remove the main 
battery pack or it discharges 
completely, there is a 
30-minute window in which 
to insert a charged battery pack before the backup battery discharges 
completely. If your backup battery discharges completely, the contents 
of the RAM memory will be lost. A backup battery that is less than fully 
charged has a proportionally smaller window of time available.

LED Indicators

Red LED On Charging
Green LED On Battery is full of fully charged
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Features of the 7100
Take a moment to become familiar with the layout of the keypad and the 
functions of the various keys.
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Touch screen display
The display is an LCD (Liquid Crystal Display) with a 4-wire analog 
resistive touch screen. The 2.8” (1/4) VGA (Video Graphic Array) features 
transmissive active matrix color, backlighting, and 240 x 320 resolution.

Care and cleaning of the 7100
When needed, clean the scanning lens and the LCD display with a clean, 
nonabrasive, lint-free cloth. You can clean the 7100 case with a damp cloth.

The 7100 ships with a screen protector already installed over the touch 
screen lens to help prevent damage that may occur due to frequent use. If 
you wish to remove this screen protector, do NOT do so before initial use. 
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Using the Follett 7100 stylus
The 7100 comes with a stylus, located in the cloth stylus slot on the back of 
the hand strap. Use this stylus (or your finger) to select or enter information 
on the touch screen display. The stylus functions like a mouse; generally, a 
tap is the same as a click.

Tap: Tap the touch screen once to open 
menu items and select options.

Drag: Hold the stylus on the screen and 
drag it across the screen to select 
text and images.

Tap & hold: Tap and hold the stylus 
on an item and a pop-up 
menu appears.

CAUTION: Use of objects, such as 
paper clips, pencils, or ink pens on the 
touch screen can damage the input 
panel and may cause damage not 
covered by the warranty.

Basic keys
Name Function

ALPHA Toggles keyboard between alphabetic (upper and 
lowercase) and numeric modes. Indicator on command 
bar changes accordingly. 

BKSP 
(Backspace)

Performs the same function as the Backspace key on a 
workstation keyboard. 

CTRL 
(Control)

When pressed with another key, modifies the other 
key to type specific characters or performs a certain 
function.

ESC (Escape) Cancels an action.
ENT (Enter) Performs the same function as the Enter key on a 

workstation keyboard.
POWER Suspends and resumes the terminal.
SCAN Activates the image engine to scan a barcode or take 

an image.
SPACE Performs the same function as the Space bar on a 

workstation keyboard.
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Alphanumeric keyboard 
The keyboard defaults to numeric mode. Use the ALPHA key to toggle 
between numeric and alphabetic modes. Pressing the ALPHA key once 
locks the keyboard in numeric mode, press it again to lock it in lowercase 
alphabetic mode, and once again to lock it in uppercase alphabetic mode. An 
icon on the command bar indicates the alpha/numeric status of the keyboard.

Function keys
Pressing the FUNC key with another key enables a new function on your 
device. For example, pressing FUNC with the 5 key increases the brightness 
of the screen. 

Key Combination Function
FUNC + 1 F5 (Launches internet access)
FUNC + 2 F6 (launches Control Panel)
FUNC + 3 F7 (Tab)
FUNC + 4 Toggles wireless radio on and off
FUNC + 5 Increases screen brightness
FUNC + 6 Increases volume
FUNC + 7 Same as Tab
FUNC + 8 Decreases screen brightness
FUNC + 9 Decreases volume

FUNC + . Displays Start menu

FUNC + 0 Deletes
FUNC + SP Aligns the screen (Press ESC to 

exit.)

Note: Blue text below each key indicates these key combinations.
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CTRL key combinations 
Pressing the CTRL key with another key performs certain functions or 
modifies the other key to type specific characters.

Key Combination Function
CTRL + 1 ! 
CTRL + 2 @ 
CTRL + 3 # 
CTRL + 4 $
CTRL + 5 %
CTRL + 6 ^
CTRL + 7 &
CTRL + 8 (
CTRL + 9 )

CTRL + . -  (minus)

CTRL + 0 *
CTRL + SP + (plus)

Note: Yellow text below each key indicates these key combinations.

Program buttons
Use the Program Button feature in the Control Panel to program buttons 
to execute different functions. The following buttons on the 7100 are 
preprogrammed for the listed function. 

Press and hold the FUNC key and press the appropriate function key to 
execute the indicated function.

Key Function
F1 Internet Explorer
F 2 Email
F 3 Scan Wedge
F 4 Follett Remote
F 5 Pocket CMD
F 6 Control Panel
F 7 Transcriber

Note: Follett Remote should be closed by selecting File then Exit.
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Wireless radios (wireless communication)
Follett 7100s have a 2.4 GHz 802.11b/g WLAN (Wireless Local Area 
Network) radio that uses DSSS (Direct Sequence Spread Spectrum) 
technology. The radio is interoperable with other 802.11b/g, Wi-Fi compliant 
products, including access points (APs), workstations via PC card adapters, 
and other wireless portable devices.

By default, the 802.11b/g radio is enabled after each hard reset, which 
means that the radio begins transmitting a signal as soon as the terminal 
finishes booting up. The next step is to configure the connection parameters 
of the radio to connect to a wireless network.

Once you configure the 7100 for your network, you can communicate 
wirelessly.
• If you are a Destiny customer, you can communicate directly with Des-

tiny.
• If you are a Circulation Plus®/Catalog Plus® or InfoCentre™ customer, 

you can connect to the Internet.

Establishing a successful wireless connection depends heavily on your 
network infrastructure. You need specific information from your network 
administrator to configure the 7100 for your network.

Connecting to a wireless 802.11 b/g wireless 
network
The 7100 contains an integral Network manager for the on-board 802.11b/g 
radio.

The Wireless Radio supports the following protocols: WEP, 802.1x, LEAP, 
TKIP, MD5, EAP-TLS, EAP-TTLS, WPA-PSK, WPA v2.0, PEAP.

For the above protocols that support EAP authentication, the 7100 supports 
the following methods:

• LEAP     •    FAST-GTC
• PEAPv0-MSCHAPV2   •    FAST-TLS
• PEAPv1-MSCHAPV2   •    TLS
• PEAPv1-GTC    •    TTLS-MD5
• PEAPv1-TLS    •    TTLS-MSCHAPV2
• FAST-MSCHAPV2   •    TTLS-GTC

To communicate with your wireless network, you need to turn the power on to 
the radio and configure your WLAN settings on the 7100.
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Enabling the WLAN radio driver
The radio driver must be enabled for the radio to transmit a signal. You 
cannot connect to a network unless the radio is enabled. To enable to driver, 
tap the UP arrow in the lower right corner of the screen, or press FUNC + 4.

Configuring a wireless connection
Important: A cold boot of the 7100 could delete the WLAN settings. You may 
want to record this data in a secure place.

1. To open the network manager, tap  in the taskbar.
2. To enable the radio, tap the up arrow and turn wireless LAN on.
3. Open the Config tab and click New.  

(If you would rather scan for existing wireless network devices, tap 
Scan.)

4. On the Network dialog, type in your SSID (network name).
5. Select the Association Mode of your network configuration from the list.

Select To connect with
None No authentication or encryption.
WEP WEP encryption
IEEE 802.1X (WEP) WEP encryption and EAP authentication. 
WPA-Personal (PSK)  
WPA2-Personal (PSK)

WPA encryption and PSK authentication.

WPA-Enterprise (EAP)  
WPA2-Enterprise (EAP)

WPA encryption and EAP authentication.

The fields and options required by the association mode, encryption, and 
EAP methods appear in the Network Window after each is selected.

6. If required by the association mode, select the Encryption method.
7. If required by the association mode, select the EAP Method.
8. If required or desired, enter keys or passwords.
9. (Hide the Input Panel, if open) Tap OK at the bottom. Back on the 

Config tab, your SSID now appears in the list.

All server-assigned IP addresses use Dynamic Host Configuration Protocol 
(DHCP).
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Activating a wireless connection
On the Config tab, select the network in the list and tap Activate. The 7100 
attempts to connect to the network according to the parameters you entered 
above.

Please note that the 7100 will not attempt to connect until you tap Activate. 
The Config tab stores all the configurations you have created in the list but 
activates only one configuration at a time.

[x] appears next to the activated configuration.

To switch connections, simply select it on the Config tab and tap Activate. 

The Status tab appears, displaying the connection status.

The radio status icon in the taskbar changes to indicate the status:

Color Meaning Status tab status

Gray

 

The radio is disabled, 
idle, not connecting.

NO RADIO 
RADIO OFF 
DISCONNECTED 
INACTIVE

Yellow

 

The connection is:
Associating (icon 
stops spinning).

Authenticating (icon 
stops spinning).

Negotiating DHCP 
address (icon spins 
clockwise).

Out-of-Range.

ASSOCIATING 
AUTHENTICATING

Red

 

Authentication failed 
and the connection 
failed as a result.

ASSOCIATED 
but not authenticated

Green

 

The connection is 
authenticated with a 
valid DHCP address.

COMPLETE
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To configure the IP address:
1. Open Internet Explorer and select View > Internet Options from the 

menu.
2. Set your Start page to the IP address of your Destiny application.

Connecting to a workstation through a cable
To allow your workstation and the 7100 to communicate through a cable, you 
need the correct cable and Microsoft ActiveSync® software.

You need the following hardware:
• 7100 communication cable or a HomeBase

The USB cable allows the Follett 7100 to communicate with a 
workstation or to a network through a USB hub. The 7100 supports full-
speed USB communication (USB 1.1). Maximum data transfer rate is 12 
Mbps. As shipped, the 7100 defaults to USB communication.

• 7100 power cable from the manufacturer.
• A workstation running one of the following operating systems: Win-

dows® XP; Windows 2000; Windows Me; Windows NT® (4.0 SP6 or 
higher); or Windows 98 Second Edition.

You need the following software:
• Windows Mobile Device Center 6.1 (or higher) installed and configured 

on the workstation for Windows Vista or Windows 7.

If ActiveSync/Mobile Device Center is not installed on your host 
workstation, you can download and install the most current version from 
www.microsoft.com.

• ActiveSync 4.1 (or higher) installed on the Windows XP workstation 
and configured on the 7100.
(We ship Follett 7100s with ActiveSync already installed.)

• Mobile Device Center 6.1 (or higher) installed on Windows Vista or 
Windows 7 and ActiveSync configured on the 7100.

You must set up ActiveSync on your workstation before you connect your 
7100 for the first time.
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Setting up the workstation
Windows XP
Once you have installed ActiveSync on the workstation, you must  
configure it:
1. Double click the ActiveSync icon 

 in the system tray.
2. In the Microsoft ActiveSync 

application, select File > 
Connection Settings.

3. Select the Allow USB 
connections checkbox:

4. Click OK to close Connections 
settings, and then select File > 
Close to close the ActiveSync 
application. 

Windows Vista or Windows 7
Once you have installed Mobile Device Center on Windows Vista or  
Windows 7, you must configure it:

1. Double click the ActiveSync icon  in the system tray.
2. In the Microsoft Mobile Device Center application, select Set up your 

device.
3. In the Set Up Windows Mobile Partnership window, select the second 

option, No, I want a synchronize with two computers, and click 
Next.
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4. Leave everything unchecked on the What kinds of items do you want 
to sync? screen and click Next.

5. Name your device and leave the first option checked (Merge the 
existing items on the device with the items on the desktop). Select Set 
Up.

Setup will finish and the partnership will be established.
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Setting up the 7100
As shipped, the 7100 defaults to USB communication with your workstation. 

To verify or change the default setting:

1. Tap  (Start) > Settings > Control Panel > PC Connection.

2. Tap Change Connection to change the current settings.

Connection Options Select an option to …

115200@Desktop Establish an RS-232 connection.
Infrared Port Establish an ActiveSync connection via 

the IrDA Port. 
USB Establish a USB connection

3. Double tap OK to close PC Connection, and tap OK again to close PC 
Connection Properties.
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Connecting the USB cable

Connect the USB cable to the I/O connector on the 7100 and to a USB port 
on the workstation.

This is a communication-only cable unless you plug the power cable into the 
power port.

Connecting the power cable

The Power Port on the back end of the USB connector fits the power 
cable that comes with each Follett 7100. To charge the device while 
communicating, connect the power cable to the Power Port.

Communicating with the 7100
After setting up both the workstation and the 7100, an ActiveSync connection 
should be automatic.

When you connect the 7100 to a communication peripheral, such as the 
communication cable, the 7100 opens ActiveSync to establish a connection 
automatically.
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Uploading Follett Remote files from the 7100 to 
your workstation 
ActiveSync on Windows XP

When you have connected the 7100 to the workstation, ActiveSync should 
open automatically. If not, open ActiveSync on the workstation by double 
clicking the ActiveSync icon  in the system tray.

1. Click Explore on its toolbar. The 
Mobile Device folder opens in 
Windows Explorer.

2. Locate and transfer your Follett 
Remote files by dragging 
and dropping—or copying and pasting—them to a location on your 
workstation, just as you would when moving any files between folders.

You will find your Follett Remote files in \IPSM\Follett Remote.

Uploading the files from the workstation to your 
application
Once you have moved your Follett Remote files to your workstation, you can 
upload them to your application. In Destiny, once you regain your wireless 
connection, you can upload the files through the browser.
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Circulation Plus/Catalog Plus v6.4
You can upload Follett Remote data files anywhere that accepts files from a 
PHD:

Cataloging
Edit > Update Copies via PHD
Edit > Remove Categories via PHD
Edit > Delete Copies via PHD

Circulation Desk
Circulation > Remote Circulation

Inventory
Inventory > Remote Inventory

Patron Maintenance

Edit > Update Patrons via PHD
Edit > Delete Patrons via PHD

Reports

Bibliography Report > Select by: Titles via PHD
Title List > Select by: Titles via PHD
Patron Barcode List > Select by: Patrons via PHD
Patron Cards > Select by: Patrons via PHD
Patron Name List > Select by: Patrons via PHD

To upload a file:
1. Select Data File from the Select the PHD model list. 
2. Click Browse to locate and select your Follett Remote file.
3. To use a transaction date other than the one shown, enter the desired 

Date.
4. To begin uploading the file, click Proceed.
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InfoCentre v3.0
To process Follett Remote circulation transactions:
1. On the Admin tab, click Circulation.
2. Click Follett Remote.
3. On the Follett Remote window that appears, click Load File.
4. Browse to and select your Follett Remote file.
5. To use a transaction date other than the one shown, click Transaction 

Date and select one.
6. To use a due date other than the one shown, click Due Date and select 

one.
7. To begin uploading the file, click Process.

Mobile Device Center on Windows Vista or Windows 7
When you have connected the 7100 to the workstation, Mobile Device 
Center should open automatically. If not, open ActiveSync on the workstation 
by double clicking the ActiveSync icon  in the system tray.

1. Under the File Management option, select Browse the contents of 
your device.
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2. A Windows Explorer screen opens and displays the Contents of the 
device.

3. Navigate to \IPSM\Follett Remote\ to locate all your Follett remote files.

Destiny
You can upload Follett Remote data files from several pages in Destiny.

If you have transferred the Follett Remote files to your workstation:
1. Open the appropriate screen and select your options.
2. To locate and select your barcode file, click Browse.
3. To start the processing, click the Upload, Update, or Run Report 

button at the bottom of the screen (depending on the screen).
4. Check the job summary in Job Manager in the Back Office tab to 

review any exceptions.

If you are uploading the Follett Remote files wirelessly:
1. After logging in, tap Upload File.
2. On the Upload File page, select the type of file you are uploading.
3. For offline circulation, verify or change the Transaction Date.

For inventory, select the one you are working on.
In Textbook Manager, select your Location.
For textbook or asset transfers, select the destination site.
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4. Tap Browse to locate and select your Follett Remote file in the \IPSM\
Follett Remote folder.

5. Tap Upload.

Once you see the message, Your uploaded file has been sent to the Job 
Manager, you can continue with other tasks.

Finishing up
Once you have uploaded your files to your application and no longer need 
them, make sure to delete them from both your workstation and your 7100.

When your application has finished processing the file, make sure to review 
the exceptions report or Job Summary.

Problem Resolution
If your 7100 exhibits erratic operation or does not seem to be functioning 
correctly, you may wish to try a warm reboot by using the stylus to press the 
small recessed Software Reset Key next to the Power key. If this still does 
not correct the problem, you can try a cold boot by pressing the reset button 
and then pressing and holding the Power key.
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User Notes
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